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USE IN LIFE SUPPORT DEVICES OR SYSTEMS MUST BE EXPRESSLY AUTHORIZED.

STMicroelectronics PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL COMPONENTS IN
LIFE SUPPORT DEVICES OR SYSTEMS WITHOUT THE EXPRESS WRITTEN APPROVAL OF STMi-
croelectronics. As used herein:

1.Life support devices or systems are those 2. A critical component is any component of a life
which (a) are intended for surgical implant into support device or system whose failure to per-
the body, or (b) support or sustain life, and whose form can reasonably be expected to cause the
failure to perform, when properly used in accord- failure of the life support device or system, or to
ance with instructions for use provided with the affect its safety or effectiveness.

product, can be reasonably expected to result in
significant injury to the user.
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INTRODUCTION

A microcontroller is needed for communication in DALI dimmable ballast applications. A com-
munication protocol and the interface parameters have been defined by the leading manufac-
turers of lighting equipment. This interface is currently in the process of international standard-
ization and will be included in Annex E of the IEC929/ EN60929 international standard for
electronic ballast performance requirements. The draft of the standard can be obtained from
the standard documentation institutions in the same way as other IEC documentation.

For more information about DALI, visit the information platform at http://www.dali-ag.org/

STMicroelectronics offers a dedicated ST7DALI microcontroller in its standard 8-bit ST7 micro
family, and fully documented free software in ANSI-C, which is fully compliant with this
standard (Annex E.4). The corresponding test procedure (Annex G) has been followed to val-
idate the compliance. The software is described in application note AN1601.

This evaluation kit allows you to evaluate the STMicroelectronics solution.

As a first step, from a master board connected by RS232 to a user-friendly PC software, you
can send DALI commands to the DALI slave boards and see the action on the light (or on
yellow LED).

Then, when you start a design, you can consider the slave board itself, hardware and soft-
ware, as a reference design for a DALI gateway topology.

Figure 1. ST7DALI-EVAL Evaluation Kit
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KIT CHECKLIST

1 KIT CHECKLIST

The ST7DALI-EVAL evaluation kit contains the following items:
1 CD-ROM

1 Master board

2 Slave boards

1 4-wire cable (12V supply + DALI bus)

1 RS232 DB9 null-modem cable

1 AC/DC adaptor (13.5V DC 600mA)

8/32

4




HARDWARE FEATURES

2 HARDWARE FEATURES

2.1 DALI SLAVE BOARD
ST7DALI flash microcontroller with DALI communication module
1-10V output (standard dimmable ballast input)

DALI communication interface (This interface passes the IEC standard 60929 “Physical oper-
ational parameters” test sequences).

12V supply connector.
No need for an external resonator, ST7ZFDALI has an internal 1% RC oscillator

The 12V power for the board is supplied from the master board. An LD2980 linear voltage reg-
ulator converts to 5V. The board outputs an analog signal between 1 to 10V to control a
standard dimmable ballast.

J1 Input connector: 12V, 0V, DALI1, DALI2
J2 output connector: 0-10V
Green and red LEDs: indicate if the slave was addressed by the last command or not

Yellow LED: Displays the 1-10V output level

2.2 MASTER BOARD

DALI communication interface

RS232 communication interface

AC/DC adaptor input

J1 Output connector: 0V, 12V, DALI1, DALI2
P1 Input/output connector: RS232

Green and red LEDs:

Limitation:

The master board power supply does not fully meet the DALI bus specification. It has been de-
signed especially for this evaluation kit, to be connected to 2 slave boards only. The function-
ality is not guaranteed if more slaves are connected to the bus.

4

9/32




GETTING STARTED

3 GETTING STARTED

3.1 PC SOFTWARE INSTALLATION
The PC software runs under Win NT, Win 2000, Win98 & Win95
Run the Setup.exe file on the CD-ROM. And follow the indications.

3.2 MICROCONTROLLER SOFTWARE
ST72C334 (master board) and ST7DALI (slave board) are already programmed.

3.3 CONNECTING THE BOARDS
Connect both slave boards and the master boards with the 4-wire cable

You can optionally connect a dimmable ballast, with a standard 1-10V input, to each slave
board to run the demo (not provided with this evaluation kit). Otherwise, a yellow LED on the
slave board allows you to see a corresponding change in the level of the lamp.

Connect the master board to the PC serial port with the RS232 null-modem cable
Connect the AC/DC adaptor to the master board

Plug the AC/DC adaptor on the mains. Important note: after this operation, send a Full
Search command (Select “Extras” menu, item “Search for Ballasts...”.) and a Quick Search
command (Select “Extras” menu, item “Search for Ballasts...”.).

3.4 RUNNING THE PC SOFTWARE
On the PC, run “PowerControl” in Start/Programs/ST7Dali.

The user interface consists of a main window and 5 other windows. The main window is al-
ways visible.

Select “View” menu to choose other visible windows.

Figure 2. Main window

.STHicmelectmnics -- DALI Control 2.0

Filelh."iew Optionz  Extraz Help
Chl + Ballazt Grid

Bdius v LightLevel Slider

v Selechon
l v DALILogger

4
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GETTING STARTED

Windows:

Ballast Grid window: ballasts found on the bus after a Search

Light Level Slider window: buttons and sliders for adjusting light level parameters
Selection window: Buttons for selecting groups

Scene window: buttons for selecting scenes

DALI logger window: displays all DALI commands sent

3.5 BASIC COMMANDS
3.5.1 Addressing the ballasts
Select “Extras” menu, item “Search for Ballasts...”.

The following window appears:

Figure 3. Figure 3: Search for Ballast window

— Tupe of Search
& Quick Search
™ Full Search Cloze

Start Search

" Physical Selection

Tatal of Ballazsts found: O
If a Quick Search doez not find all B allaztz, run a Full Search.

Run a “Full Search”. When it is finished, run a “Quick Search”.
The master will find two ballasts on the network. The ballast window shows these ballasts.

See Section 4.1 Addressing ballasts for more details on this topic.

4
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GETTING STARTED

Figure 4. Screen overview after a Quick Search
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3.5.2 Light level

You can choose to change the light level of only selected ballasts or all ballast by pushing ei-
ther the “Selected” or the “All” buttons in the “Light Level” Window.

You can change the light level by pushing the up “>>” and down “<<” buttons, or by moving the
slider.

Figure 5. Light Level window

Light Level

+J 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 L]
kin 1 bl ax
ey | B | Fade Time |

I Power I Al Selectedl Simulate Fading | Fade Rate ’ s 1

Ballasts change the light level immediately. Push the “Update” button in the “Ballasts” window
to update all the ballast light level in the “Ballasts” window. To do so, the master asks each bal-
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GETTING STARTED

last on the network its actual level (QUERY ACTUAL LEVEL command). The colors in the
“Ballast” window represent the light level (black for 0%, yellow for 100%).

Figure 6. Ballasts window after clicking on Update

L
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4 PC SOFTWARE FEATURES

4.1 ADDRESSING BALLASTS
4.1.1 Full Search

A “Full Search” is an example of address allocation to be done after a DALI system installa-
tion. Each ballast (up to 64) must have a short address.

The procedure is the following:
To start the algorithm, the master sends the INITIALIZE command

The master sends the RANDOMIZE command to make each ballast generate a 24-bit random
number

The master searches the ballast with the lowest random number (SEARCHADDRH, SEAR-
CHADDRM, SEARCHADDRL, COMPARE commands) and a short address (6-bit) is as-
signed to this ballast (PROGRAM SHORT ADRESS command). This ballast stores this short
address in the ST7DALI E2PROM.

The programmed short address is verified (VERIFY SHORT ADDRESS command)
This ballast is removed from the search process (WITHDRAW command)

This procedure is repeated until all ballasts have a short address. The process is stopped by
the TERMINATE command.

If two or more ballasts have the same short address, the addressing procedure is restarted
only for these ballasts with the INITIALIZE command.

All the successive commands are displayed in the DALI logger window.

From now, every ballast on the network has a short address, stored in the microcontroller's
E2PROM.

4.1.2 Quick Search

A “Quick Search” searches ballasts with a short address, connected on the DALI bus. The
master uses the QUERY BALLAST command.

4.2 SIMULATE FADING
This operation is done by pushing the “Simulate Fading” button in the “Slider” window.

Fade time and fade rate parameters can be adjusted by sliders. Push the “Apply” button to val-
idate the modifications.

The fading can be done either on “All” or “Selected” ballasts.

4
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PC SOFTWARE FEATURES

The target light level is chosen by moving the slider with the mouse. The simulation will begin
as soon as you release the left mouse button, taking into account the Fade time and Fade rate
parameters.

4.3 CONFIGURATION
Select “Options” menu, item “Configuration...”

The following window appears:

Figure 7. Configuration window

Configuration E |
— Configuration
The Command applys to | all $E|EI:':EI:|| Ballasts,
— Groups
Save Currently zelected Ballaztz as Group... IM vI (] |
— Scenes
Save Lightlevel of allfselected]  store MASE to unzelected I] az Scene IU 'I ok |
— Reset
Execute RESET on all/zelected Ballastz now. Thiz deletes Scenes, Groups, Fadetime. .. ]

Cancel

Choose if you want the following action to apply to “All” or only “Selected” ballasts by pushing
the right button at the top of the window.

4.3.1 Storing a Group

Choose the number x of the group you want to create with the combo. Push the “OK” button
to define the group number x.

The group’s name can be customized by selecting the “Option” menu, item “Change group
names...”

4
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Figure 8. Names of groups

Names of Groups x|
Reset to Defaults
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|Eru:uup3 |Gru:uup1'|
IEn:uupd IGru:uup'IE
IErDupE IGr-::up'IS
|I3r|:|upE |Gru:uup14
IEn:uup? IGru:uup'IE
k. Apply | Cancel |

4.3.2 Storing a Scene

Choose the number x of the scene you want to create with the combo. By pushing the “OK”
button, the actual light level of selected or all ballasts will be stored as Scene number x. The
master makes each addressed ballast storing the actual level as its scene x level.

The scene name can be customized by selecting the “Option” menu, item “Change scene
names...”

4
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Figure 9. Names of scenes

Hames of Scenes x| I

Rezet to Defaultz

|5cene 1] |5|:ene 3
|Sn:er'|e 1 |S|:ene 9
ISEEHEE ISn::ene'IEl
|S|:er'u33 |Sn:ene'|1
IScened ISn:ene'IE
|S|:er'u35 |S|:ene'|3
|SceneE |S|:ene'|4
ISEEHE? ISn:ene'IE
Apply | Cancel |

4.4 ADDRESSING COMMANDS TO A GROUP

Select a group by pushing the corresponding button in the “Groups” window.

4
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Figure 10. Group window
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Group 13
Group 14
Group 15

4.5 CALLING BACK A SCENE

A scene can be called back by pushing the corresponding button in the “Scene” window. The
master sends a GO TO SCENE, and a QUERY ACTUAL LEVEL command to every ballast.
Each ballast outputs the level corresponding to this scene, previously stored in the microcon-
troller's E2PROM.

4
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Figure 11. Scene window

Scene ]
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4.6 MANUAL DALI INTERFACE

Select the “Options” menu, item “Send DALI command...”

The following window appears:

4

Scene 15
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Figure 12. Manual DALI interface window

im. Manual DALI Interface =]
— Execute DALl Command
—Autarmatic

Command Address Data

] | o[ = s

— bl anual

Byte #1 Biyte #2 Flags Expected &nzwer

A = | £ I

— Bnswer

Cloze

4.6.1 Automatic Command

An “Automatic” command can be sent by choosing a command in the “Command” combo box.
All DALI commands defined in the EN60929 are available (See summary of the command set
in draft, section E.4.3.5).

The second combo box allows the recipient(s) to be chosen:
Broadcast: all ballasts connected on the DALI bus

Group xx: all ballasts in the xx group (xx between 0 and 15)
Short yy: ballast with the short address yy (yy between 0 and 63)

The third combo box is the data associated with the command. This parameter can be irrele-
vant, depending on the command. But it always needs to be filled out.

If the command is a “Query” command, the answer of the ballast addressed is displayed at the
bottom of the window. (If the query is addressed to more then 1 ballast, an error occurred)

Example:

In the following window, a push on the “Send” button will put the light level of the ballast which
has the short address 3 to a level of 11.

4
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Figure 13. Light Level window

im. Manual DALI Interface =]
— Execute DAL Commarnd

—Autarmatic

Command Address
Direct ARC Power Contral j IShDrtS

— bl anual

Byte #1 Biyte #2 Flags Expected &nzwer

| = = =l [ send

4

— Bnswer

Cloze

4.6.2 Manual Command
In this way the user has to fill the 2 bytes. Refer to EN60929 to know command codes.

4.7 RUN AUTOMATED DEMO

Select the “Extras” menu, item “Run automated demo”.

The following window appears:

Figure 14. Automated demo configuration window

Bun Demo x|
Seftingz

Set Timer Interval [me); 1000
h

—

Loop ta this Scene, then restart:

Feady

LM | Cancel |
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Set the timer interval x and the last defined scene y.
Push the “RUN” button to start the demo.

The master will go from Scene 0 to Scene y, and then restart from Scene0, with an interval of
x milliseconds between each.

4.8 SAVE/LOAD CONFIGURATION
Select the “File” menu, item “Save...” to save the actual configuration.

Select the “File” menu, item “Load...” to load a configuration.

4
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5 DALI SLAVE BOARD FEATURES

5.1 LEDS
5.1.1 Green and red LEDs

The green or red LED on each slave board indicates if the board was addressed or not by the
last command sent by the master.

For example, if you select both ballasts before changing the light level, the green LED will be
switched on both slave boards. On the other hand, if you select only one ballast before
sending a command, the green LED will be switched only on one addressed slave, and the red
LED will be switched only on the slave that is not concerned by the command.

5.1.2 Yellow LED

The yellow led displays the 1-10V output level corresponding to the light level. It is especially
useful if you do not want to connect a ballast to the 1-10V output.

5.2 JUMPER

This jumper allows you to measure the ST7DALI microcontroller current consumption (partic-
ularly in halt mode).

4
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5.3 DALI INTERFACE

TALT Eu:
hiBZ 5
4+ g 3
DLl R
R
1] o~
500 500
RT
L4 Of Ra L& 1
111\‘_44 H 11\\‘_44 1%
%E BASTE 1K %E
2, = L 0.1% 2, = L2
SFHG166-2 | SFHG156-2
R1D Ri1
32 R 4R7 R1Z
0.1% 1% 10K
1%
R13 3 D5
+ 11 21 1
1K21 p7 T 5 BZHIR4C T =
0.1% IiuF BCE17-25
200
Ri4
3K16
DALl TH 0.1%

5.4 ST7DALI SOFTWARE
The software is compliant with Annex E of the IEC929/ EN60929 standard.

A tester performing all the tests defined in Annex G of the standard has been used to validate
the ST7DALI DALI software.

Refer to AN1601 for a description

5.5 HALT MODE

The ST7DALI-EVAL evaluation board can be used to measure the extremely low consumption
of the microcontroller in Halt mode, by measuring the voltage on jumper 4.

4
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DALI SLAVE BOARD FEATURES

5.6 SOFTWARE DESCRIPTION
The DALI slave software is described in AN1601.
Source code and environment setup files for STVP7 are included in the CD-ROM.

The software can be compiled with both Cosmic and Metrowerks compilers.

5.7 REPROGRAMMING THE MICROCONTROLLER

The microcontroller can be reprogrammed through the ICP connector using:
STMicroelectronics ST7 Flash STICK

Softec INDART ST7F/D (www.softecmicro.com)

5.8 DEBUGGING THE APPLICATION
The user can debug in two different ways:

- Emulation using a ST7MDT10-EMUS3 (in this case, solder a DIP20 to SO20 device adaptor/
socket onto the board. See ST7MDT10-EMUS3 Probe User Guide, section 3.6).

- In circuit debugging with a Softec INDART ST7F/D (www.softecmicro.com).

5.9 USEFUL DOCUMENTATION

Related documents are:

AN1601 - Software Implementation for ST7DALI-EVAL

AN1756 - Choosing a DALI Implementation Strategy with ST7DALI
AN1900 - Hardware Implementation for ST7DALI-EVAL

4
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6 APPENDIX: BOARD SCHEMATICS AND BILLS OF MATERIAL

6.1 DALI GATEWAY SLAVE BOARD

6.1.1 Slave board Schematics

J1

1200

4
2evme | 3
DALt Bus

MC 1 5%

Jin

N auT
Cumert-test
‘T‘HCZ
1ul
Iﬁ

LDQQSDAB U50TR

HEMS-CETOHE y

00 SO0

Lo
HShdG-CHTD

i?K‘@ i 2K49 BZKE IDD F
0% o1 04% B0

1noC
iy

, ‘ua —s o ‘LIE ” [ l: RES‘EF _?;;+
z SZEF% 3 BTEG 3.11K1 b SZ:F;‘S 3 I : :
T % T TPZ M HOLE
6.1.2 Slave Board Bill of material
Item | Qty | Reference Value Voltage| % | Footprint Description Ref RS
. 262-
o,
1 2 C2,C3 1uF 20V 10% 3216 Tantalium 4397
264-
2 4 [C1,C4,C5,C6 100nF 50V 10% 0805 X7R 4416
3 |1 C7 22uF 20V | 10% 6032 Tantalium 262-
4636
. 215-
4 2 R1, R2 2K49 1/4w | 0.1% 0805 Resistor
2850
5 | 1 R6 3K3 14w | 1% 0805 Resistor 223-
0499
6 | 1 R3 82K5 14w |0.1% | 0805 Resistor 215
) 4525
. 223-
7 3 | R4,R5,R12 10K 1/4w 1% 0805 Resistor 0562
8 | 2 R7,R8 0 14w | 1% 0805 Resistor 223
’ 0146
9 1 R9 11K 1/4w | 0.1% 0805 Resistor 215-
' 3544
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APPENDIX: BOARD SCHEMATICS AND BILLS OF MATERIAL

Item | Qty | Reference Value Voltage| % | Footprint Description Ref RS
10 1 R10 332R 1/4w | 0.1% 0805 Resistor 12;154
o . 344-
11 1 R11 4R7 1/4w 1% 0805 Resistor 6279
12 1 R13 1K21 1/4w | 0.1% 0805 Resistor 215
2513
13 1 R14 3K16 1/4w | 0.1% 0805 Resistor 215-
2951
14 1 R15 150K 1/4W 1% 0805 Resistor 223
0714
15 1 R16 4K7 1/4w 1% 0805 Resistor 223-
0528
16 1 LD1 HSMS-C670HE 0805 Red Led CMS 2mA |429-546
17 1 LD2 HSMG-C670 0805 Green Led CMS 2mA [429-568
18 1 LD3 LYT670 Yellow Led 428-830
19 1 D4 MB2S Bridge Diode 269-366
20 | 1 D5 BZX284C2V7 0805 Zener 2.7V g;gé
. 436-
21 1 D6 BAS-16 SOT23 Diode 7773
22 1 u2 TS271CD S08 Operational amplifier [ STM
23 1 (UK} ST7FD£LIF2M S020 Micro STM
Optoisolator output 284-
24 | 2 U4, U5 SFH6156-2 S04 NPN Transistor Input
DC 1190
ULTRA LOW DROP
25 1 0]5; LD298.|9:BU50 SOT89 |VOLTAGE REGULA-| STM
TORS
26 1 Q1 BC817-25 SOT23 NPN Transistor STM
Connector, PCB, 220-
27 1 J1 MC 1,5/4-G  |Connect header, 3.81mm pitch,
4 way 4850
Connector, PCB, 220-
28 1 J2 MC 1,5/2-G  |Connect header, 3.81mm pitch,
4822
2 way
29 1 J4 Connect Current Sense 251-
8086
Connr, rect, header, 120-
30 1 J3 Connector Connect IDC, low profile box,
) 7230
straight mount, 10 way
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Item | Qty | Reference Value Voltage| % | Footprint Description Ref RS

Connector, PCB,
screw terminal, cable | 220-
mount, 3.81mm pitch | 4658

2 way

31 1 Connector Connect

32 1 Connector |Connect jumper link 334-561

6.2 DALI MASTER BOARD

6.2.1 Master Board Schematics
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6.2.2 Master Board Bill of material

Item |Qty Reference Value (Voltage| % gzz: Description Ref RS
C1,C2,C3,C5,Cs6, o . 264-
1 7 C7.013 100nF 50V 10% | 0805 Capacitor Type X7R 4416
2 1 C4 220nF 50V 10% | 0805 Capacitor Type X7R i?gs
custom- . . 262-
3 |3 C8, C9, C11 1uF 20V | 10% Tantalium Capacitor
er 4327
o, |custom- . . 262-
4 1 Ci14 22uF 20 10% or Tantalium Capacitor 4636
o . 223-
5 2 R1,R5 0 1% 0805 Resistor 0146
6 1 R2 220 1/2W | 5% RCO05 Resistor 132-337
o . 223-
7 2 R3,R4 10K 0.1W 1% 0805 Resistor 0562
8 1 R6 11K 0.1W | 0.1% | 0805 Resistor 215-
' e 3544
9 |2 R7,R8 2K49 0.1W | 0.1% | 0805 Resistor 215
’ ' e 2850
10 | 1 R9 1K21 0.1W 1% 0805 Resistor 215
' e 2513
. 215-
11 |1 R10 332R 0.1W | .1% | 0805 Resistor 1914
12 | 1 R11 4R7 0.1W 1% 0805 Resistor 344-
' s 6279
13 | 1 R12 3K16 0.1W 1% 0805 Resistor 215-
' s 2951
14 | 1 R15 4K7 0.1W | 1% 0805 Resistor 223
' ° 0528
15 | 1 D1 BZX§502 2oV DO41 Diode Zener 812-544
16 | 1 D2 MB2S 200V TO- BRIDGE SMD 269-366
269AA
HSMG-
17 | 1 LD3 C670 HE 0805 Red Led SMD 429-546
18 | 1 LD4 HSMG- 0805 Green Led SMD 429-568
C670
BzZ84C2V . 216-
19 D5 7 2.7V 0805 Diode Zener 9599
20 | 1 D6,D7 BAS16 S0T23 Diode 436-
) 7773
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Item |Qty Reference Value ([Voltage| % E?lﬁ: Description Ref RS
Murata 16Mhz (or
CSA16.0 CST16.00MXWAOQCS3 or 179
21 | 1 X1 O0MXZA04 CSACV16.00MXA040Q -
3810
0 or
CSTCV16.00MXAOQH3Q)
22 |1 Q1 802851 & SOT23 NPN Transistor STM
ST7202C RS-232 DRIVERS AND
23 | 1 U1 D SO16 RECEIVERS STM
ST72C33 .
24 | 1 u2 4J4B6 SDIP42 Micro STM
SFH6156 . 284-
25 | 1 us,u4 2 S04 Opto-isolator 1190
KF120BD
T/ VERY LOW DROP VOLT-
26 | 1 Us L78M15C DPAK AGE REGULATORS STM
DT
LD2980A ULTRA LOW DROP VOLT-
27 |1 U6 BU5S0TR SOT89 AGE REGULATORS STM
o8 | 1 i Connec- Connector, PCB, header, 220-
tor 3.81mm pitch, 4 way 4850
286-
29 | 1 J2 Jack PCB socket 2.5mm 8763
Connec- Connr, re:ct, header, lIDC, 120-
30 | 1 J4 low profile box, straight
tor 7230
mount, 10 way
31 [ 1 P1 RS232 RS 232 SOCKET for PCB |457-484
32 4-wire cable, terminated with three Connectors for cable mounting RS code 220-4670
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“THE PRESENT NOTE WHICH IS FOR GUIDANCE ONLY AIMS AT PROVIDING CUSTOMERS WITH INFORMATION
REGARDING THEIR PRODUCTS IN ORDER FOR THEM TO SAVE TIME. AS A RESULT, STMICROELECTRONICS
SHALL NOT BE HELD LIABLE FOR ANY DIRECT, INDIRECT OR CONSEQUENTIAL DAMAGES WITH RESPECT TO
ANY CLAIMS ARISING FROM THE CONTENT OF SUCH A NOTE AND/OR THE USE MADE BY CUSTOMERS OF
THE INFORMATION CONTAINED HEREIN IN CONNECTION WITH THEIR PRODUCTS.”

Information furnished is believed to be accurate and reliable. However, STMicroelectronics assumes no responsibility for the consequences
of use of such information nor for any infringement of patents or other rights of third parties which may result from its use. No license is granted
by implication or otherwise under any patent or patent rights of STMicroelectronics. Specifications mentioned in this publication are subject
to change without notice. This publication supersedes and replaces all information previously supplied. STMicroelectronics products are not
authorized for use as critical components in life support devices or systems without express written approval of STMicroelectronics.
The ST logo is a registered trademark of STMicroelectronics.
All other names are the property of their respective owners
© 2004 STMicroelectronics - All rights reserved
STMicroelectronics GROUP OF COMPANIES
Australia — Belgium - Brazil - Canada - China — Czech Republic - Finland - France - Germany - Hong Kong - India - Israel - Italy - Japan -

Malaysia - Malta - Morocco - Singapore - Spain - Sweden - Switzerland - United Kingdom - United States
www.st.com
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